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MOLECULAR MODELLING EXERCISES  
 
EXERCISE  24.3   COMPARISON OF OPIOID ANALGESICS          
           

INTRODUCTION 
Morphine (Fig. 1) is a natural product extracted from opium, and is one of the oldest 

pharmaceuticals used in medicine (Chapter 24 in the textbook). It is a multicyclic structure that 

contains a rigid carbon skeleton. SAR studies have shown that the phenol and the basic amine are 

the key functional groups for analgesic activity. Because of the rigid nature of the molecule, the 

molecule has only one major conformation, which corresponds to the active conformation. In this 

exercise, you will construct an analgesic pharmacophore for morphine then compare that with the 

pharmacophores of various analgesic structures to compare their similarity. This exercise is very 

similar to exercise 2, but here we will create pharmacophores from all of the relevant structures, 

before carrying out the overlays.   

 

 
Figure 1 Morphine 

 

INSTRUCTIONS 
It is suggested that you attempt to carry out the following instructions yourself before 
following the more detailed Procedures that follow. You may find the file entitled Common 
Operations for ChemBio3D/Chem3D a useful guide on how to carry out various operations.  
 

 

Part A) Open the ChemDraw file for morphine (available from the ChemDraw folder) into 

ChemBio3D or Chem3D. Create a pharmacophore consisting of the aromatic ring, the phenol 

oxygen and the nitrogen atom. Create dummy bonds to form a pharmacophore linking the nitrogen 

to the oxygen and the centroid. Note you will have to retain the aromatic carbon atoms in the 

diagram since these define the position of the centroid. Alter the shades of each colour. Measure the 

dimensions of the pharmacophore triangle. 

 

Part B) Open the ChemDraw files from the ChemDraw folder for levorphanol, metazocine, 

meperidine, methadone, and Met-enkephalin (Fig. 2). Create the pharmacophores for these 

structures. Copy the analgesic pharmacophore of morphine into each of these windows and carry 

out the overlay. 
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Figure 2 

 

  

  Part C) Enter the dimensions of the pharmacophore triangles for morphine, levorphanol, 

metazocine and Met-enkephalin into a spreadsheet for comparison 
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PROCEDURES 

There are various approaches that you can use to tackle these molecular modelling exercises. 
The following procedures illustrate how you might tackle this particular exercise, but they are 
not meant to be prescriptive. Note also that the results obtained may vary depending on the 
computer and the version of ChemBio3D used. For example, the specific conformations 
obtained from energy minimisation may differ, as may quantitative results such as steric 
energies. 
 
 
PART A) Creating the analgesic pharmacophore of m                       

      

 
Morphine 
 
1. Create the energy-minimised structure of morphine 
*Open ChemBio3D or Chem3D.  
*From the File menu, choose Open, then select the ChemDraw file for morphine from the 
ChemDraw folder. Click Open. The 3D structure of morphine will appear in the window. 

*Energy minimize  the structure (Fig 3). The steric energy is shown in the bottom window 
as 28.5 kcal/mol.  
 

 
Figure 3 Energy-minimised structure of morphine. 
 
 
2. Create the analgesic pharmacophore for morphine 
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The crucial features for analgesic activity in morphine are the phenol group, the aromatic ring, and 

the basic nitrogen. We are going to create a pharmacophore which consists purely of these features 

and remove the molecular scaffold holding these in place. 

*Click on the erase icon  from the top menu bar and d all the atoms except for the 

oxygen of the phenol group, the six aromatic carbons, and the nitrogen atom. The nitrogen atom is 

no longer bonded to any other atom, but if you rotate the structure you will see that the program 

keeps the nitrogen in the same relative position to the aromatic ring.  

We will now create a dummy atom at the centre of the aromatic ring to define its position.  

*Choose the select tool . 

*With the shift key depressed, click on all 6 carbon atoms of the aromatic ring.  

*From the Structure menu, choose Add Centroid. 

*Select the bond tool  and create a dummy bond between the nitrogen and the centroid (Fig. 

4A). This now represents the analgesic pharmacophore.  Do not energy minimize it or you will alter 

the relative positions of the atoms. 

  
  A      B 

 

Figure 4 Pharmacophore for morphine. 

 

3. Reshade or recolour the atoms of the pharmacophore.  

Reshading the pharmacophore will make comparisons clearer when aligning it with different 

analgesic structures.  

*Choose the select tool . 

*With the shift key depressed, select all the carbon atoms to highlight them. 

*Hover the mouse over any of the chosen atoms, then right click the mouse to produce a menu. 

*Select Color, then Choose color.  

*Select your chosen colour from the resulting colour palette, then click on OK.  

*Repeat these operations to recolour the nitrogen and oxygen atoms. The pharmacophore (Fig. 4B) 

is now ready to overlay with pharmacophores from other structures. 
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PART B   

We will now create the pharmacophores for levorphanol, metazocine, meperidine, methadone, and 

Met-enkephalin, then overlay them with the pharmacophore derived from morphine.  

 

1. Create the energy-minimised 3D structures of levorphanol, metazocine, meperidine, 

methadone and Met-enkephalin  
*Open the relevant ChemDraw files from the ChemDraw folder into separate windows of 

ChemBio3D or Chem3D as described in part A. 

*Energy minimize the structures .  

*From the View menu, choose Model Display, then choose Show Hydrogen Atoms. Choose 

Hide.  

*From the View menu, choose Model Display, then choose Show Lone Pairs. Choose Hide.  

The structures obtained (Fig. 5) have the following steric energies (in brackets);  

levorphanol (22.8 kcal/mol),  metazocine (25.4 kcal mol), meperidine (20.5 kcal/mol), methadone ( 

27.4 kcal/mol) and Met-enkephalin (-33.9 kcal/mol).  

 

 

    
  A       B  

    
   C     D 
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  E 
 

Figure 5  3D models of levorphanol, metazocine, meperidine, methadone, and Met-enkephalin. 

 

 

2. Modify the conformation of the piperidine ring in metazocine  

The piperidine ring in metazocine is likely to have a twist boat conformation (Fig. 6A). This can be 

converted to the chair conformation as follows. 

*Go to the window with metazocine. 

*Choose the Select tool . 

*Click on nitrogen to select it. 

*From the Structure menu, choose Invert. 

*From the Calculations menu, choose MM2, then Molecular Dynamics. A table will come up 
showing default entries including a Target Temperature of 300 K.  
*Keep the default values and click Run. You will see the molecule vibrating and adopting 
various conformations.  
*Once the chair conformation has been formed, click on Stop Calculation on the menu bar 

.  

*Energy minimise  the conformation to provide metazocine with the chair conformation 
(Fig. 6B). The structure now has a steric energy of 18.9 kcal/mol, which is more stable than the 

conformation with the twist boat conformation. 
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  A      B 

Figure 6 Modification of metazocine A) Inversion of nitrogen B) Chair conformation after 

molecular dynamics and energy minimization.       

  

 

3. Add centroids to the aromatic rings of the various opioid structures. 

*Choose the select tool .  
*With the mouse key depressed, click on all the carbon atoms in an aromatic ring 

*From the Structure menu, choose Add Centroid. 
 

The structures should now look as follows (Fig. 7) 

 

 

   
 

  
 

Figure 7  Levorphanol, metazocine, meperidine, methadone, and Met-enkephalin with centroids. 

 

4. Delete atoms and create dummy bonds to produce pharmacophores for each structure. 

 

*Use the eraser to remove all the carbon atoms except those in the aromatic rings. 

*Use the eraser to remove the heteroatoms, apart from the nitrogen of the amine group, and the 

oxygen of the phenol group. 

*Use the single bond tool  to create a dummy bond between nitrogen and the centroid.  The 

resulting pharmacophores should now look as follows (Fig. 8). 
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Figure 8     Pharmacophores for levorphanol, metazocine, meperidine, methadone, and Met-

enkephalin. 

 

 

5. Overlay the pharmacophore of morphine with that of levorphanol  

 

*Copy and paste the pharmacophore triangle for morphine into the window containing the 

pharmacophore for levorphanol. 

*Align the structures such that they are similarly orientated. 

*Pair up corresponding atoms ready for the overlay (Fig. 9A). 

*From the Structure menu, choose Overlay, then click on Minimise. A dialogue box will 
appear.  
*Retain the default values and click Start. The resulting overlay is shown in figure 9B. 
You will see that the pharmacophores are well aligned with the paired atoms separated by only 0.0 

Å-0.1 Å. The distance between the nitrogen atoms of the two pharmacophores is 0.1 Å.     
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  A     B 

 

Figure 9   A) Alignment of pharmacophores for morphine and levorphanol B) Overlay 

 

6. Overlay the pharmacophore of morphine with that of metazocine  

Carry out the same procedures to align the pharmacophores and pair up the atoms (Fig. 10A). The 

overlay (Fig. 10B) is also good 0-0.2 Å). The distance between the nitrogen atoms of the two 

pharmacophores is 0.2 Å.     

 

  

  

 

 

 

   
   A      B 

 

Figure 10 A) Alignment of pharmacophores for morphine and metazocine B) Overlay   

   

 

7. Overlay the pharmacophore of morphine with that of meperidine  

In this case, meperidine lacks a phenolic oxygen, and so the pairings involve the nitrogen atoms, the 

centroids and the aromatic carbon atoms. 
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The overlay of the analgesic pharmacophore with meperidine is not so good (0.1-1.0 Å) (Fig. 11), 

and the separation between the nitrogen atoms is 1.0 Å. This is not too surprising since the N-

centroid separation is significantly longer for meperidine at 5.7 Å, compared to the centroid-N 

separation of 4.5 Å for morphine (Fig. 12). 

 

          

 

 

                
 

 
 

   

Figure 11  A) Alignment of pharmacophores for morphine and meperidine B) Overlay 

 

 
Figure 12 Centroid-nitrogen distance in the pharmacophore of meperidine. 

   

8. Overlay the pharmacophore of morphine with that of methadone  

Here, we have two aromatic rings in methadone, either of which might be part of the 

pharmacophore. The first overlay is poor with paired atoms separated by 0.1-1.5 Å (Fig. 13B). The 

nitrogen atoms are 1.5 Å apart. 
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Figure 13 A) Alignment of pharmacophores for morphine and methadone B) Overlay 

 

The overlay is influenced by the choice of paired atoms and the pairing above puts a priority on the 

aromatic carbon atoms. The overlay can be repeated by just pairing the nitrogen atoms and the 

centroids (Fig. 14). This not only diminishes the emphasis on the aromatic ring, but also means that 

the orientation of the ring plays no role. The resulting overlay is slightly better, but the N atoms are 

still 0.8 Å apart.   

 

   
 

Figure 14 A) Alternative pairings  B) Overlay 

 

 

The overlay with the second aromatic ring was carried out using just the nitrogen atoms and 
the centroids (Fig. 15). 
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 Figure 15 A) Alignment of pharmacophores for morphine and methadone B) Overlay 

 

This is a much better overlay with the nitrogen atoms and centroids perfectly aligned. However, the 

aromatic rings are angled with respect to each other. A measurement of the two centroid-nitrogen 

distances shows that the latter corresponds well with the corresponding distance in the morphine 

pharmacophore (Fig. 16) 

 

  
 

Figure 16  A) N-Centroid Distances in the methadone pharmacophore B) Corresponding structure 

of methadone with corresponding distances. 

 

9. Overlay the pharmacophore of morphine with that of Met-enkephalin  

 

In this case, the pairings were of the nitrogen atoms, the oxygen atoms and the centroids. 

The overlay with Met-enkephalin results in separations of 0.5-0.6 Å (Fig. 17). This is fairly good 

considering the fact that the conformation used may not be the active conformation. Including the 

aromatic carbon atoms in the pairings resulted in poorer overlays. 
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Figure 17 A) Alignment of pharmacophores for morphine and Met-enkephalin B) Overlay 
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PART C) 

Pharmacophore triangles can be defined for morphine, levorphanol, metazocine, and Met-

enkephalin. The points of the triangle represent the oxygen atom of the phenol, the nitrogen atom of 

the amine, and the centre of the aromatic ring. In this part, we will create these triangles from the 

pharmacophores created in Part B. 

 

1. Create pharmacophore triangles for each of the relevant pharmacophores. 

*Choose the bond tool .  

*For each of the relevant pharmacophores, create dummy bonds between the nitrogen atom and the 

oxygen atom, and between the oxygen atom and the centroid. 

*Choose the eraser  and delete the aromatic carbon atoms to produce the pharmacophore 

triangles (Fig. 18). 

 

 

 
 

Figure  18. Pharmacophore triangles for A) morphine, B) levorphanol, C) metazocine and D) Met 

enkephalin  

 

2. Measure the lengths of each side of the pharmacophore triangles  

*From the Structure menu, choose Measurements, then Generate All Bond lengths. The 
table of bond lengths appears in the Measurements Table to the left of the main window.  
*To display the measurements on the pharmacophore itself, tick the select box to the left of 
each measurement. The distances are now displayed in the main window (Fig. 17). 
 
3. Measure the angles of each pharmacophore triangle  

*Deselect the length measurements in the Measurements Table. 
*From the Structure menu, choose Measurements then Generate All Bond Angles. A table 
of bond angles appears in the Measurement Table. 
*Click in the small box to the left of the relevant measurement(s). The measurements are 
displayed in the main window (Fig. 18).  
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Figure 18  Dimensions of pharmacophore triangles. 

 

 

The angles of the triangles are as follows 

 
Angles  Morphine Levorphanol Metazocine Met-Enkephalin 

N-Du-O  149.4   147.5   142.0  163.2 

Du-O-N       19.1      20.2    22.5    10.9 

Du-N-O      11.5      12.3    15.5      5.8 

 

 

 
 


